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Chapter 1: Welcome to Sage 100
Contractor Installation
Welcome to Sage 100 Contractor installation. Sage 100 Contractor can run inmany different software and
network environments, with implications you need to consider as you prepare to install the software. Themore
you understand about the installation process and how it relates to your software and network environment,
themore likely your installation will proceed smoothly.

This chapter provides more information about customer resources, such as:

Other printed and printable guides

The user-assistance Help system

Contacts for Customer Support

Sage 100 Contractor training

Information about business partners.

How to read this document
This document uses the following conventions:

The names of screens, windows, fields, and other features displayed by the software are shown in bold
type.

Information you enter into the software is in bold type, as in the following example:
EnterMiscellaneous in theAmount Type box.

Names of keys are shown in capitals; for example, ENTER, TAB. A plus sign (+) between two key
names indicates that you should press both keys at the same time; for example, SHIFT + TAB.

The names of buttons you can click with your mouse are enclosed in bold type; for example, [OK] and
[Post].

TIP: This symbol draws your attention to helpful information tomake it easier for you to use Sage 100
Contractor.

NOTE: This symbol draws your attention to information of particular interest, such as information not
included in steps.

CAUTION: This symbol draws your attention to information that is important because it can help you
avoid a costly or time-consuming error.

IMPORTANT: This symbol draws your attention to information that is of critical importance.
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Customer Support and resources
IMPORTANT: Before you contact the Customer Support Call Center, take advantage of the following
resources, which are available 24 hours a day, 7 days a week.

Sage 100 Contractor Help
From anywhere in the Sage 100 Contractor software, you can display this comprehensive library of
accessible topics to learnmore about specific procedures, topics, fields, or buttons.

Product documentation
The software comes with several PDF guides, includingRelease Notes, Installation and License
Administration Guide, andUser Guide, among others.

To view the guides, click Home & Resources tab > Product Documentation or, if you have Activity
Centers hidden, click Resources > Printable Documentation.

Sage Knowledgebase
Depending on your Sage service plan, we offer a web-based Sage Knowledgebase and online user
community forums at www.na.sage.com or through the in-product menu. Our staff maintains an extensive
knowledge database of questions and answers covering everything from frequently asked questions tomore
complex problems and solutions. In addition, we keep all product reference documentation available in the
Knowledgebase. This online tool is the same tool we use in our customer support call center to help answer
your call.

To log in to the Sage Knowledgebase:

1. Go to https://support.na.sage.com/.

2. In the upper-right section of the page, above the Search, click Login.

3. Enter your Customer Portal Username andPassword.

4. Click Log on.

Contacting Customer Support
Depending on your Sage service plan, youmay be able to contact the Sage Customer Support Call Center to
work with one of our highly trained customer support professionals. The Knowledgebase article How do I get
technical support for Sage 100 Contractor? provides contact information and hours of operation, and it can
help you to determine which service works best for you.

Our analysts work with you to respond accordingly to the urgency of your issue.

Call urgency can range from a simple explanation of software settings to critical situations in which work is
stopped or data integrity is compromised. Some calls may warrant further research and followup, in which
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case our support analyst will place your call in his/her in-progress work list. At every step of the way, we work
with you until we reach a resolution or agreement.

Depending on your Sage service plan, youmay check the status or update, or even create a new support
ticket online:

1. Visit www.na.sage.com.

2. In the upper-right section of the page, above the Search, click Login.

3. Enter your Customer Portal Username andPassword.

4. Click Log on.

5. On the right, select Submit a customer support case.

Before you call customer support

Be sure to have the following information on hand so we can handle your call efficiently.

Question How to Find the Answer

What is your Sage client
ID number?

Your client ID number can be found on correspondence you receive from
Sage. If you do not know your Sage client ID, contact the person at your
company whomaintains your relationship with Sage.

What software version
are you using?

To find the version, open Sage 100 Contractor; clickHelp > About
Sage 100 Contractor and note the number listed.

What application or area
in the software are you
calling about?

On themenu list, identify the application and window where are you
are working (i.e. Selecting Invoices to Pay in 4-3-1, Accounts Payable
Vendor Payments).

How can we help you? Walk through the exact steps you completed with asmuch detail and
accuracy as possible.

Is there an error mes-
sage? Write down the exact wording of themessage.

Can you reproduce the
issue?

Were you able to walk through the same steps that led to the problem
and see whether it happened again?

Is this the first time the
problem has happened?
Does the problem occur
on one workstation or sev-
eral?

Ask other users if they have experienced the same problem. Have
them test at their workstation to see if they experience the same prob-
lem. Also, have the original user try other workstations to see whether
the problem is specific to that user.

Customer Support and resources
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Question How to Find the Answer

Has anything changed
with your software, hard-
ware, or workflow?

Ask your network administrator for technical information regarding any-
thing that may have changed behind the scenes: upgrades to Sage
100 Contractor, new third-party software installations, moving of data
from one server to another, new printers or print driver installation, or
anything else that might affect the network.

Does the problem hap-
pen in the sample data
sets?

Select [File> Open Company], then change the drive letter on the
dropdown to C:, select Sample Company.

What kind of network are
you using? If you do not know, contact your network administrator.

What operating system is
on your computer?

For Vista: Click [Start], type winver in the ‘start search’ window and click
[OK].

What printers and print
drivers are installed? If you do not know, contact your network administrator.

When was your last
backup? If you do not know, contact your network administrator.

Training resources
When you choose to take online classes from Sage or work with a Sage business partner, you will learn how
to use Sage 100 Contractor to support your business. Contact your business partner to find out about training
options or visit Sage University at http://www.sageu.com.

Online classes
Online classes help youmaximize your use of Sage 100 Contractor. Online classes are a convenient training
option for your company and new users to learnmore about Sage 100 Contractor so you can get themost out
of the software. You can select from classes on all aspects of Sage 100 Contractor, including project
management, estimating, scheduling, servicemanagement and payroll. Each online class is led by an
instructor with years of experience using Sage 100 Contractor. During the class, you will be able to follow
along as the instructor demonstrates functions and workflows in Sage 100 Contractor. In the online live
session, you can ask questions and benefit from hearing answers to other students' questions.

For more information, visit http://www.sageu.com.

Getting started as a new user
We recommend that all new users should begin with our New Customer Training (NCT) series, which is
included in our Essentials Training Package in recorded format for 24/7 access. If you prefer live online
training led by an instructor, you can register for the Realtime Learning version of these NCT courses. For
more information, visit http://www.sageu.com.
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Business partners
To serve you better, Sage 100 Contractor products and services are available to you through an authorized
network of business partners. Business partners have local expertise and regional knowledge working with
contractors in the region.

Your business partner is available to serve you, from simple how-to questions and hands-on demonstrations,
to installation, implementation, and training. They're fully equipped to help you get where you want to be. For
more information, contact your Sage 100 Contractor business partner.

The Users Group
TUG, The Users Group for Sage 300 Construction and Real Estate, Sage 100 Contractor, and Sage
Estimating is a not-for-profit, professional organization committed to supporting the users of Sage 100
Contractor and other Sage construction software.

You can find out more about the group, their services, and how to become amember at http://tugweb.site-
ym.com/default.asp?.

Business forms
Sage 100 Contractor is designed to work with generic cheques and forms that are available frommany
sources. There is no single vendor that customers must use; however, you can get a complete portfolio of
forms, tax forms, and cheques throughSage Construction and Real Estate Forms by calling 800-760-7929 or
by visiting www.sagecreforms.biz.

Business partners

Installation and License Administration Guide 5

http://tugweb.site-ym.com/default.asp?
http://tugweb.site-ym.com/default.asp?
http://www.sagecreforms.biz/




Chapter 2: System Configuration
This chapter presents technical information about how to configure Sage 100 Contractor for specific operating
systems.

For current information about supported operating systems, Internet browsers, and other software, and about
system requirements for servers and client workstations, refer to our Knowledgebase article ID 62172,
available at https://support.na.sage.com/selfservice/viewdocument.do?externalId=62172.

Make sure your computers meet the system requirements before you install the software. Sage 100
Contractor may not run properly or at all on computers that do not meet theminimum requirements.

Internet access required for Sage 100 Contractor
Sage 100 Contractor features, such as printing or efiling tax forms, submitting enhancement requests,
accessing Help, or downloading periodic product or tax updates all require Internet access.

To take advantage of these features, ensure that any workstation or server that Sage 100 Contractor is
installed on has access to the Internet.

During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to
connect to the Internet to obtain licenses. Once installation is complete, you can check out license uses for
each computer where Sage 100 Contractor is installed, then disconnect the Sage license server from the
Internet.

NOTE: A static Internet connection using a compatible web browser is required for Sage Construction
Anywhere. For current information on supported browsers, supported Sage 100 Contractor versions, and
other system requirements, see the Sage Construction Anywhere help at
http://help.sageconstructionanywhere.com/sage100contractor/help/Default.htm#01_Setup/System_
requirements.htm.

Network configuration and licensing

About network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable
communication among computers on a network. By default, Sage 100 Contractor uses the TCP starting port
48750. Certain configurations can potentially disable the communication:

File sharing on computers running theWindows 8, Windows 7, Vista, Server 2008, Server 2008 R2, and
Server 2012 operating systemmust be enabled. To enable file sharing, follow the instructions in the
Windows Help.

TCP communication requires the selection of port numbers that are not in use by other processes on the
local computer.

Software firewalls running on the local computer can be configured to block processes from opening TCP
ports, which will prevent communication through the TCP Remoting Channel.

Installation and License Administration Guide 7
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Configuring Sage 100 Contractor Hosting Framework TCP port number
Sage 100 Contractor uses the TCP starting port number 48750 as the default. You can configure the port
number using the XML file Sage.CRE.HostingFramework.Service-InstanceConfig.xml, located in the
Programs (x86)\Sage\Sage 100 Contractor folder.

If you need to change the default port numbers for the Sage 100 Contractor Hosting Framework using the
Sage.CRE.HostingFramework.Service-InstanceConfig.xml file, youmust change it on every computer on the
network where Sage 100 Contractor is installed. In addition, after making this change, the Sage 100
Contractor Hosting Framework on each computer running Sage 100 Contractor must be restarted.

NOTE: Consult your IT administrator for alternative port numbers.

To change the port numbers:

1. InWindow Explorer, locate Sage.CRE.HostingFramework.Service-InstanceConfig.xml in the path
Programs(x86)\Sage\Sage 100 Contractor.

2. Right-click Sage.CRE.HostingFramework.Service-InstanceConfig.xml, then open it with a text editor,
such as Notepad.

3. Near the end of the file, between the <StartingPort> </StartingPort> tags, locate the port number.

4. Change the port number.

5. Save, and then close the file.
Repeat these steps on every computer running Sage 100 Contractor.

Configuring anti-virus software and third-party firewalls
During installation of the Sage 100 Contractor Hosting Framework, theWindows Firewall is configured
automatically to allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some
other firewall, however, youmay need tomanually adjust some settings in the firewall in order to ensure
proper operation.

You can use the following basic procedure tomanually configure theWindows Firewall to allow the Sage 100
Contractor Hosting Framework to communicate with other computers. Use it as the basis for manually
configuring other third-party firewall products.

To configure the Windows Firewall:

1. ForWindows Vista or Server 2008, click Start > Control Panel > Security.

ForWindows 7, click Start > Control Panel > System and Security

ForWindows 8, click Start > All apps > Control Panel > System and Security.

2. OpenWindows Firewall, and then select Allow a program or feature through Windows Firewall.

3. If Sage 100 Contractor Hosting Framework is not on the list, you can add it by selectingAdd Program,
then browsing to the following path:
\MB7\Programs\Sage.CRE.HostingFramework.Service-InstanceConfig.xml.

Chapter 2: System Configuration
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NOTE: By default, the exception is set to allow access by any computer on the network. You can refine
this setting by selecting theChange Scope button. Be aware that restricting the scope incorrectly can
cause the computer to be unable to connect with some or all of the other machines on the network.

Files to exclude when manually configuring your firewall for Windows 8 Professional
32-bit

C:\MB7

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files\Sage\Sage 100 Contractor

C:\ProgramData\Aatrix Software

C:\Program Files\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 8 Professional
64-bit

C:\MB7

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files (x86)\Sage\Sage 100 Contractor

C:\Program Files (x86)\Aatrix Software

C:\ProgramData\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Vista 32-bit
C:\MB7

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files\Sage\Sage 100 Contractor

C:\ProgramData\Aatrix Software

C:\Program Files\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Vista 64-bit
C:\MB7

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files (x86)\Sage\Sage 100 Contractor

Network configuration and licensing

Installation and License Administration Guide 9



C:\Program Files (x86)\Aatrix Software

C:\ProgramData\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 Professional
32-bit

C:\MB7

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files\Sage\Sage 100 Contractor

C:\ProgramData\Aatrix Software

C:\Program Files\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 Professional
64-bit

C:\MB7

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files (x86)\Sage\Sage 100 Contractor

C:\Program Files (x86)\Aatrix Software

C:\ProgramData\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 8 Professional
C:\MB7

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files (x86)\Sage\Sage 100 Contractor

C:\Program Files (x86)\Aatrix Software

C:\ProgramData\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Server 2008, 2011,
2012

C:\MB7

Chapter 2: System Configuration
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C:\ProgramData\Sage\Sage 100 Contractor

C:\ProgramFiles (x86)\Sage\Sage 100 Contractor

C:\Program Files (x86)\Aatrix Software

C:\ProgramData\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

Windows permissions required for Sage 100 Contractor
When you install Sage 100 Contractor, work with your system administrator to configure theWindows-level
security that corresponds to the operating system installed on each workstation where Sage 100 Contractor
will be used. Without the correct permissions, users may have difficulty operating Sage 100 Contractor.

CAUTION: Always back up your data before changingWindows permissions! SettingWindows
security incorrectly can adversely affect system operations. Sage is not responsible for problems
caused by incorrectly configuredWindows settings.

All the directories listed below must have Full Control,Modify, Read & execute, List folder contents,
Read, andWrite permission. Special permissions are not required.

Permissions required

Windows component/
version Directories

Registry Keys

HKEY_Current_User\Software\Sage

HKEY_Local_Machine\Software\Wow6432node\Sage

HKEY_Current Config\Software\Sage 100 Contractor PDF Export

HKEY_Current Config\Software\Sage 100 Contractor RTF Export

Windows 8 Professional 32-bit

C:\MB7

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files\Sage\Sage 100 Contractor

C:\ProgramData\Aatrix Software

C:\Program Files\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

Windows 8 Professional 64-bit C:\MB7

Windows permissions required for Sage 100 Contractor
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Windows component/
version Directories

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files (x86)\Sage\Sage 100 Contractor

C:\Program Files (x86)\Aatrix Software

C:\ProgramData\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

Windows 7 Professional 32-bit

C:\MB7

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files\Sage\Sage 100 Contractor

C:\ProgramData\Aatrix Software

C:\Program Files\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

Windows 7 Professional 64-bit

C:\MB7C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files (x86)\Sage\Sage 100 Contractor

C:\Program Files (x86)\Aatrix Software

C:\ProgramData\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

WindowsServer 2008, 2011,
2012

C:\MB7

C:\ProgramData\Sage\Sage 100 Contractor

C:\ProgramFiles (x86)\Sage\Sage 100 Contractor

C:\Program Files (x86)\Aatrix Software

C:\ProgramData\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

Chapter 2: System Configuration
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Windows component/
version Directories

WindowsVista 32-bit

C:\MB7

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files\Sage\Sage 100 Contractor

C:\ProgramData\Aatrix Software

C:\Program Files\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

WindowsVista 64-bit

C:\MB7

C:\ProgramData\Sage\Sage 100 Contractor

C:\Program Files (x86)\Sage\Sage 100 Contractor

C:\Program Files (x86)\Aatrix Software

C:\ProgramData\Aatrix Software

C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

Report scheduling and faxing functionality

About setting up emailing and faxing through Sage 100 Contractor
Using the faxing functionality through the Sage 100 Contractor program requires:

Installation of theWindows operating system Fax Service component

A separate installation and setup of a fax modem in your workstation

Access to an analog phone line.
In addition, you will also have to set up the cover page information and the number of times that the fax re-tries
to send.

For more information about installing and setting up your fax modem, refer to the documentation that came
with your fax modem. Sage 100 Contractor does not provide support for installing or setting up a fax modem.

For more information about installing theWindows operating system Fax Service component, see Installing
theWindow Fax Services component.

Report scheduling and faxing functionality

Installation and License Administration Guide 13



Upgrade to the latest version of Adobe Reader

Adobe Reader supports faxing fromWindows. To fax from Sage 100 Contractor, you should download and
install the latest version from http://get.adobe.com/reader/.

Disable automatic updating for Adobe Reader

If you are using the scheduling capability for sending faxes, we recommend that you disable the automatic
“check for updates” capability of Acrobat Reader as it will prevent scheduled reports from completing.

NOTE: Instructions for disabling automatic “check for updates” differ from version to version of Adobe
Reader. Refer to the Adobe Reader Help for instructions.

Report Scheduling and Email Functionality

IMPORTANT: Using the email capability of Sage 100 Contractor requires Microsoft Outlook or access
to a simplemail transfer protocol (SMTP) email server.

TheEmail Settingswindow provides a way for you to set up email. You can change the selections to
accommodate different emailing preferences.

You can access theEmail Settingswindow through:

Any Report Printingwindow by clicking theEmail button on the toolbar to open theEmail Distribution
windows. Then, click theEmail Settings button to open theEmail Settingswindow.

7-9 Alerts Manager

Click onSettings in the Dispatch Board, then click onEmail Setup.

Sage 100 Contractor and SMTP

IMPORTANT: The SMTP server may be located on your workstation PC, on a server on your
company’s network, or at your Internet service provider (ISP). If the email server is local, youmay need
the assistance of an IT professional to properly identify or set up this capability. If the email server is
located at your ISP, youmay need contact your ISP for assistance.

Using the ISP’s simplemail transfer protocol (SMTP) server to send email via Sage 100 Contractor typically
requires “user authentication” at the STMP server. An example of an SMTP email server name is
smtp.att.sbcglobal.net.

Different ISPs may use different terms when referring to user authentication. In general, however, user
authenticationmeans verifying a user’s identity by means of a “user name” and “password.”

In the context of sending email through Sage 100 Contractor using an ISP’s SMTP server, user authentication
only refers to verifying the user’s identity at the ISP’s SMTP server. It does not refer to your:

Sage 100 Contractor user name and password

Network domain user name and password

Windows system user name and password.

Chapter 2: System Configuration
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NOTE: Wedo not provide support for setting up or installing an email server. You set up user
authentication and your fax line access dial out number on 7-2 Company Information.

Installing the Windows Fax Services component
To fax from Sage 100 Contractor, youmust install theWindows Fax Services component:

Vista:

1. Click Start > Control Panel > Programs > Turn Windows features on or off.

2. On theWindows Featureswindow, locate theWindows fax and scan check box, then select it.

3. Click [OK].

Windows 7:

1. Click Start > Control Panel > Programs > Turn Windows features on or off.

2. On theWindows Featureswindow, locatePrint and Document Services, then click theWindows
fax and scan check box.

3. Click [OK].

Windows 8:

1. Click Start > All apps > Control Panel > Programs > Turn Windows features on or off.

2. On theWindows Featureswindow, locatePrint and Document Services, then click theWindows
fax and scan check box.

3. Click [OK].

Windows Server 2012

Detailed information fromMicrosoft

Report scheduling and faxing functionality
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Chapter 3: Sage 100 Contractor
Installation
This chapter provides detailed information and instructions for installing Sage 100 Contractor software in
different environments, such as:

Single user

Peer-to-peer

Network

Installation preview

Pre-installation information for new customers
Implementing and running your business in Sage 100 Contractor must be thoroughly planned out in advance to
harness the power of this software. Your existing company datamust bemigrated before you start working in
the program. Your business partner can assist you with a datamigration and business implementation plan.
For more information about implementing Sage 100 Contractor for your company, see the information about
business partners in Chapter 1 of this guide.

We recommend that you take full advantage of all the knowledge and advice found in Sage 100 Contractor
documentation and training classes. We also recommend that you work with your business partner and
accounting professionals before you begin to implement this software for your business.

IMPORTANT: We recommend that you install the Sage license server on a computer that is always
available to other computers on your network that are running Sage 100 Contractor.

Pre-installation information for existing customers
Because existing customers are working with company information and possibly with scheduled reports,
review these important points before you install the program.

NOTE: Before you install, make at least one backup copy, but consider making two backup copies of
your existing company data for an extra margin of safety.

Upgrade Paths

Upgrade
From Upgrade Path

18.x Upgrade directly to version 19.x

17.x Upgrade to 18.x, reindex your data, and then upgrade to 19.x
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Upgrade
From Upgrade Path

16.x Upgrade to 18.x, reindex your data, and then upgrade to 19.x

15.x Upgrade to 18.x, reindex your data, and then upgrade to 19.x

14.x Upgrade to 18.x, reindex your data, and then upgrade to 19.x

13.x Upgrade to 14.x, reindex your data, and then upgrade to 19.x

12.x Upgrade to 13.x, reindex your data, and then upgrade to 19.x

11.x Upgrade to 13.x, reindex your data, and then upgrade to 19.x

10.x Upgrade to 13.x, reindex your data, and then upgrade to 19.x

Duration of the installation process
Plan on at least five and possibly up to 20minutes per computer to install Sage 100 Contractor. The duration
of the Sage 100 Contractor installation depends a great deal upon each computer’s configuration. For
example, some newer computers are pre-installed with essential software required to run Sage 100 Contractor
software such as the .NET Framework 3.5 Service Pack 1. Installation to older computers may takemore
time.

Additional required software
Microsoft .NET Framework 4.0must be installed on all computers running Sage 100 Contractor software. The
installer determines if the .NET Framework 4.0 is already installed. If not, the installer installs the required
software automatically.

Plan for an additional 20minutes per computer to install .NET Framework 4.0.

NOTE: It is very important that you understand the network environments and operating systems on the
computers and server computers where you install Sage 100 Contractor software. For detailed
information about installing to different environments, see Special Configurations—Operating Systems
and Services.

About installing the Sage 100 Contractor software to different
configurations
You can install Sage 100 Contractor software tomany different configurations, for example, stand-alone,
network server, Citrix and Terminal Services servers, peer-to-peer, and workstations.

Chapter 3: Sage 100 Contractor Installation
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IMPORTANT: The optimal operational size of a peer-to-peer network running Sage 100 Contractor is
two to five workstations. Additional workstations may adversely impact Sage 100 Contractor response
times. Networks consisting of more than five (5) workstations may need to use one computer as a
dedicated server.

Sage 100 Contractor allows users to share data and reports stored on a network hard drive. From different
workstations, users can then access the server to share one set of data, one set of reports, and one set of
report forms.

During installation, the installer checks for the components necessary to run Sage 100 Contractor and then
copies the programmodules and standard reports to thePrograms (x86) folder and subfolders on the hard
disk. In addition, the installation process copies system files necessary for program operations to the
Windows andWindows System folders.

The installation process does not make any configuration changes to the computer. After installation is
complete, youmust configure the stand-alone computer, server computer, or workstation for optimal
performance.

For detailed information about configuring each server and workstation depending on its operating system,
see Chapter 8 Special Configurations—Operating Systems and Services.

Connectivity across your network
For client workstations to be able to run Sage 100 Contractor, they must all be connected to the Sage license
server. If one user sees the “Sage 100 Contractor can’t communicate with the designated Sage license
server” message when all other people are connected, then you know that the connectivity problem is limited
to that one person. If you encounter a hardware failure with your license server, then no one will be able to run
Sage 100 Contractor.

Mapping a network drive to access a company
Youmay have tomap to a network drive to access a Sage 100 Contractor company if it is not located on a
drive on your local computer. Let’s suppose that the company has beenmoved to network drive Z: Now to
access the company data, you have tomap to drive Z.

To map a network drive to access a company:

1. On yourWindows desktop, click Start > Explore.

2. On the toolbar, click Tools > Map Network Drive.

3. On theMapNetwork Drive window, click [Browse].

4. Locate the drive, and then click [OK].

5. On theMapNetwork Drive window, click [Finish].

6. On the Company List window, select drive Z.

7. Select the company, and then click [OK].

Installation preview
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Installing the Sample Company
The Sample Company provides themeans for viewing and working with sample data in Sage 100 Contractor
windows. There are sample accounts, sample employees, sample takeoffs, andmuchmore. By viewing and
working with this sample data, you can gain an understanding of how different windows interact with the
sample data whenmanaging a construction business with Sage 100 Contractor.

Sage 100 Contractor master trainers use the Sample Company extensively during Sage 100 Contractor
training classes. We highly recommend that you load the Sample Company during your initial installation.

You can log on to the Sample Company using “Supervisor” as the user name. You do not need a password.

The Sample Company:

Allows you a safe way to try out new functions as you learn them.

Is used inmany online and recorded classes.

Provides samples of many Sage 100 Contractor forms that are all filled in. This makes it easy to
understandmany concepts.

Provides starter lists for many values you'll need to set up: cost codes, cost types, tasks, client status,
client type, employee positions, paygroups, and so on.

Provides you with live data to investigate the content of Sage 100 Contractor reports.

Takes very little space on your hard disk drive.
Installing the Sample Company overwrites any previous installations of the Sample Company. If you have
made changes in your Sample Company that you want to keep, rename this folder before installing a fresh
copy of the Sample Company.

New installations
A new installation is defined as installing the software on a computer that has never had Sage 100 Contractor
installed on it before.

NOTE: Instructions for reinstallation/upgrade installation over an existing installation are different. See
"Before upgrading" on page 23.

Youmust designate one computer on your network as the Sage license server. This server will manage use of
Sage 100 Contractor (for example, the number of people who can use Sage 100 Contractor simultaneously on
your network). Youmust install the software on this computer first, and then activate your licenses before
installing Sage 100 Contractor on your other computers.

Copy the entire set of installation files (all files and folder) to a folder that you create on a network drive. Install
the program to each client workstation by launching the installation from the network folder from that client
workstation. We recommend that you install to the Sage license server computer first. Then, when you install
the program to your workstations, you can set up Sage 100 Contractor to find the Sage license server and run
the program using your license.

Chapter 3: Sage 100 Contractor Installation
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The installation process also presents different installation windows depending on whether you are installing
Sage 100 Contractor as the Sage license server or you are just installing Sage 100 Contractor by itself.

IMPORTANT: Always start installing the program at the computer that will be your Sage license server,
which is likely to be your network server.

Basic steps for new installations are:
1. Install the program on your network server, the computer where all your company data is located. You

do this only once on your network.

Remember to write down the Sage license server computer’s IP Address and/or computer name, which
is displayed at the end of the installation.

2. Activate your licenses.

3. Install the program to all client workstations on your network.

4. From each client workstation, specify the Sage license server.

Installing Sage 100 Contractor on the Sage license server
Use these instructions when installing the software on the computer you’ll use as the Sage license server or if
you are running in a stand-alone environment. Stand-alonemeans that you are running Sage 100 Contractor
on one computer, or you are not networking with other computers running Sage 100 Contractor.

To install from a download package unzipped into a local or shared folder:

1. Close all open programs except for firewall and anti-virus programs.

2. Browse to the drive and folder where you downloaded and extracted the software package.

3. In the folder, locate the setup.exe file, and then double-click it.

4. On the installation option window, select the option This computer will be my Sage license server,
and then click [Next].

5. On the license agreement window, read the License Agreement carefully.

6. Select the check box to accept the terms, then click [Next] to continue the installation.

7. On the select product edition window, specify whether to install the US or Canada edition.

8. On the select additional options window, select the option Install the Sample Company for training
purposes. We recommend that you install the Sample Company.

9. Click [Install].

NOTE: The installer begins the installation process. It checks to see if the computer has .NET
Framework 4.0 installed. If this program is not found, the installer installs it.

At the end of the installation process, a confirmation window appears containing a list of installed
programs.

Sage 100 Contractor

License Administration for Sage 100 Contractor

New installations
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This window also displays the computer’s IP Address and its network name. You will use this
information to specify the Sage license server.

10. Review the list of installed programs, and write down the IP Address and network name of the
computer.

IMPORTANT: Write down and keep the Sage license server computer’s IP Address and name in
a convenient location. To select the Sage license server from client computers running Sage 100
Contractor, you need to select its name from a list or type the computer’s IP Address or name in a
text box.

11. Click [Next].
The activate your product licenses window appears. The Launch the License Administration
program check box is preselected to launch the License Administration program, so you can
activate your licenses.

12. Read the instructions about activating your product licenses, and then click [Finish], leaving the
Launch the License Administration program check box selected.

For information about this process, press F1 when viewing themain License Administration window.

NOTE: When Sage 100 Contractor is installed, an icon labeled License Administration is placed in the
Start > Programs > Sage 100 Contractormenu of Windows and a file named
Sage.SMB.LicenseAdministration.exe in thePrograms (x86)\Sage\Sage 100 Contractor folder to
provide you with the convenience and ability to view license information or update license information for
your provisioned license server while on amachine other than the provisioned license server. You can
provision additional licenses you have recently acquired to the actual license server machine without
having to be present at the actual license server.

Installing Sage 100 Contractor on client workstations

IMPORTANT: Before installing the software, close all open programs except for firewall and anti-virus
programs.

To install Sage 100 Contractor from a download package unzipped into a local or shared
folder:

1. Browse to the drive and folder where you downloaded and extracted the software package.

2. In the folder, locate the setup.exe file and double-click it.

3. Read the instructions on the installation welcomewindow, and click [Next]. 

4. On the installation option window, select the option This computer will run Sage 100 Contractor only,
and click [Next].

5. On the license agreement window, read the License Agreement carefully.

6. Select the check box to accept the terms, then click [Next] to continue the installation.

The installer begins the installation process. It checks to see if the computer has .NET Framework 4.0.
If this program is not found, the installer installs it.

7. Install the Sample Company for training purposes.
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TIP: We recommend that you install the Sample Company.

An installation complete window appears. The Launch Sage 100 Contractor check box is preselected
so that you can launch Sage 100 Contractor and specify the Sage license server.

8. Read the important message and follow the instructions to launch Sage 100 Contractor.

9. Click [Finish].

10. Sage 100 Contractor begins its launch process by displaying the Specify Sage License Server window.

NOTE: When Sage 100 Contractor in installed, an icon labeled License Administration is placed in the
Start > Programs > Sage 100 Contractormenu of Windows and a file named
Sage.SMB.LicenseAdministration.exe in the \Program Files (or Program Files (x86))\Sage\Sage 100
Contractor folder to provide you with the convenience and ability to view license information or update
license information for your provisioned license server while on amachine other than the provisioned
license server. You can provision additional licenses you have recently acquired to the actual license
server machine without having to be present at the actual license server.

Upgrade installations
If you currently have Sage 100 Contractor installed on your network computers and you are going to reinstall
it, you could be either upgrading or updating the software.

Upgrade installations involvemajor changes, enhancements, and fixes tomany parts of the program or to
modules such as licensing. For example, installing Version 19 over Version 18 is an upgrade installation
because there aremajor enhancements to the program.

Update installations, in contrast, usually involve changes to specific files, such as the
Sage.SMB.PayrollTax.dll file and report forms. These files can be changed and updated without any changes
tomajor parts of the program.

In addition, upgrade installations are different from new installations. During new installations (or reinstallation
after completely removing Sage 100 Contractor and Sage licensing), you can designate a computer to be
either the Sage license server or a client workstation.

Before upgrading
Before you upgrade your Sage 100 Contractor software, you need to complete certain preliminary tasks to
ensure the safety of your company data.

IMPORTANT: Choose a block of time when you can install the upgrade to all the computers in your
office beginning with your Sage license server. Depending on your computer’s hardware and your
network configuration, plan on 15minutes per computer for the installation process alone. Additional
tasks may take extra time.

Upgrade installations
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Before upgrading Sage 100 Contractor:

1. Back up your company data.

We suggest making two backup copies in case one of them is incomplete, becomes corrupted, or is
lost.

2. Exit Sage 100 Contractor and all other programs.

IMPORTANT: Youmust not install the Sage 100 Contractor upgrade when either Sage 100
Contractor or the Sage 100 Contractor API are running. We recommend that you shut down all
other programs when installing Sage 100 Contractor, but you do not have to shut down firewall and
anti-virus software.

3. Locate the computer on your network that is your Sage license server, and begin the upgrade
installation there.

Upgrade installation
Always begin all installations at the computer that is the Sage license server. After installing the upgrade to
the Sage license server, install the upgrade to your workstations from the image placed in a folder on the
network. For example, if you want to install Sage 100 Contractor to a network drive, you have to go to that
computer and install the program from there.

Sage 100 Contractor running on client workstations needs to connect to the Sage license server to access
your company data. If you do not change the designation of any computers on your network during an upgrade
installation, all client workstations will be able to locate the existing Sage license server again after
installation.

Installing the upgrade

When installing, use the same upgrade installation steps for both your Sage license server and your
workstation computers.

IMPORTANT: Install the upgrade to the existing Sage license server computer first. Install the upgrade
to all workstations only after the license server installation has been completed.

To install the upgrade from a download package unzipped into a local or shared folder:

1. Shut down Sage 100 Contractor and all open programs except for firewall and antivirus programs.

2. Browse to the drive and folder where you extracted the upgrade files.

3. Before you proceed further with installation, we recommend that you double-click theReleaseNotes.pdf
to open it in your PDF viewer.

Review theRelease Notes for information about enhancements, program fixes, known issues, and
other information that might affect your upgrade installation.

4. Double-click Setup.exe to begin the installation.

5. If you get amessage asking if you want to allow the following program tomake changes to this
computer, click [Yes].
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6. On the welcomewindow, notice that a previous installation has been found, and click [Next].

7. On the installation option window, select an option, and click [Next]:

a. This computer will be my Sage license server

b. This computer will run Sage 100 Contractor only

8. On license agreement window, read the license agreement carefully.

9. Select the check box to accept the terms, and then click [Next].

10. On the select additional options window, select the option to install the Sample Company. We
recommend that you install the Sample Company, which is used extensively in Sage 100 Contractor
training classes.

IMPORTANT: The upgrade installation overwrites the existing Sample Company. If you want to
save changes to the existing Sample Company, clear the check box. If you do not overwrite the
Sample Company, youmust rebuild the indexes in the Sample Company database using 7-4
Rebuild Indexes after the upgrade installation. If you havemade changes in your Sample
Company that you want to keep, rename this folder before installing a fresh copy of the Sample
Company.

11. Click [Next]. The installation proceeds.

12. On the Installation complete window, click [Finish] to launch Sage 100 Contractor.

13. Repeat steps 1 through 12 to upgrade all other computers running Sage 100 Contractor.

14. Follow the instructions for post-installation tasks to rebuild the indexes for your company database from
one computer, and reschedule your reports, as necessary.

Uninstalling Sage 100 Contractor from a Sage license server
When Sage 100 Contractor is uninstalled from an active license server, the server’s licenses are deauthorized
andmade available to be acquired by another license server. If the Sage license server crashes and the
licenses are not deauthorized, contact Customer Support to have the licenses unlocked.

If uninstalling and then reinstalling to a Sage license server, the licenses need to be reactivated after
reinstallation.

Uninstalling Sage 100 Contractor from a Sage license server
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Chapter 4: ACT! Plug-in Installation
This chapter provides information and instructions for installing the ACT! plug-in for use with Sage 100
Contractor.

Pre-installation information
For Sage 100 Contractor to integrate with ACT!, the following requirements must bemet:

Sage 100 Contractor 2013 Version 18.1 or later must be installed

ACT! Premium or ACT! PRO (version 2011 or later) must be installed

ACT! plug-in license usemust be obtained

Duration of the installation process
Plan on at least five to tenminutes per computer to install the ACT! plug-in. The duration of the Sage 100
Contractor installation depends a great deal upon each computer’s configuration. Installation to older
computers may takemore time.

Additional required software
ACT! Premium or ACT! PRO (version 2011 or later) must be installed on all computers running Sage 100
Contractor software that use the ACT! plug-in.

Plan for an additional 10 to 15minutes per computer to install ACT! Premium or ACT! PRO.

NOTE: It is very important that you understand the network environments and operating systems on the
computers and server computers where you install Sage 100 Contractor software. Chapter 6 Special
Configurations provides detailed information about installing to different environments.

Installing the ACT! Plug-in
Basic steps for installation are:

1. Verify Sage 100 Contractor and ACT! Premium or ACT! Pro (version 2011 and later) are already
installed.

2. Activate your ACT! plug-in license.

3. Install the ACT! plug-in on any client workstations where you use ACT!.

Installation of Sage 100 Contractor and ACT!

To install Sage 100 Contractor, refer to “Chapter 3: Sage 100 Contractor Installation” in this guide.
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To install ACT!, refer to the installation instructions that camewith ACT! Premium or ACT! PRO (version
2011 or later) and see the ACT! Getting Started Resource Center at http://na.sage.com/Sage-
ACT/support/Getting-Started.

Activate your ACT! plug-in license use

To activate your ACT! plug-in license, refer to “Chapter 6: Managing Your License” in this guide.

To install the ACT! plug-in on client workstations:

1. Close all open programs except for firewall and antivirus programs.

2. Browse to the drive containing Sage 100 Contractor (for example, Programs (x86) > Sage > Sage 100
Contractor).

3. Double-click ACTPluginSetup.exe to begin the installation.

4. On the welcomewindow, click [Next].

5. On the Installation complete window, click [Finish].

6. Restart your computer as necessary.

Chapter 4: ACT! Plug-in Installation
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Chapter 5: Sage Construction Anywhere
Installation
This chapter provides information about setting up Sage 100 Contractor for use with Sage Construction
Anywhere.

Additional required software
The Sage Construction Anywhere Connector should be installed on at least one computer running Sage
100 Contractor software that connect to Sage Construction Anywhere, but can also be installed to a
separate server. The Sage Construction Anywhere Connector connects your back office software to
your Sage Construction Anywhere site. The connector installation includes the Sage Construction
Anywhere Connector software and its required prerequisite software.

An Internet connection using a compatible web browser. See "Appendix A: System Requirements" for
supported browsers in the Getting Started Guide at .

NOTE: A static Internet connection using a compatible web browser is required for Sage Construction
Anywhere.

For current information on supported browsers, supported Sage 100 Contractor versions, and other system
requirements, see the Sage Construction Anywhere help at
http://help.sageconstructionanywhere.com/sage100contractor/help/Default.htm#01_Setup/System_
requirements.htm.

Duration of the installation process
Plan on at least five to tenminutes per computer to install the Sage Construction Anywhere Connector
software. The duration of the Sage 100 Contractor installation depends a great deal upon each computer’s
configuration. Installation to older computers may takemore time.

Pre-installation information
To integrate Sage 100 Contractor with Sage Construction Anywhere, youmust install and set up supported
versions of the following programs:

Sage 100 Contractor

Sage Construction Anywhere
For current information on supported browsers, supported Sage 100 Contractor versions, and other system
requirements, see the Sage Construction Anywhere help at
http://help.sageconstructionanywhere.com/sage100contractor/help/Default.htm#01_Setup/System_
requirements.htm.

NOTE: A static Internet connection using a compatible web browser is required for Sage Construction
Anywhere..
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Setting up Sage Construction Anywhere Integration
In order for Sage 100 Contractor to integrate with Sage Construction Anywhere, the following programs must
be installed and set up:

Sage 100 Contractor 2013 Version 18.3 or later must be installed

Supported version of Sage Construction Anywhere
In addition, an API user needs to be set up for any companies that are to be integrated.

In Sage 100 Contractor, in 7-3-1 Security Groups, an API security groupmust exist with the appropriate
save permissions. See "Setting up an API security group and an API user in Sage 100 Contractor" below
to set up the API group.

In Sage 100 Contractor, in 7-3-2 User List, a user that is amember of the API groupmust be set up.

Setting up an API security group and an API user in Sage 100
Contractor
Security groups let you control users’ ability to open windows as well as perform specific actions within a
window. The 7-3-1 Security Groups window in Sage 100 Contractor contains a grid with numbered rows on
the left and eight columns:

Group# (User input is required to save the record.)

Group Name (User input is required to save the record.)

Save

Delete

Void

Chg Period

Print Cheques

Notes
When you set up user groups, you type a group number and group name. Then you determine whether or not
that group will have rights toSave, Delete, andVoid records, as well as to change the accounting period and
print cheques. Youmay use the Notes column to add any pertinent information about each group.

Youmust create an API security group that is named exactly API. At least one user must be added to the API
security group. You have to set rights to save, void, and so on.

IMPORTANT: If you use security groups for the tasks performed by the employee in Sage 100
Contractor, make sure the Sage Construction Anywhere user has access to all areas of Sage 100
Contractor.
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To set up a security group for using the API
1. Open 7-3-1 Security Groups.

2. In theGroup# cell, type a group number, such as 51.

3. In theGroup Name cell, type API and do the following:

IMPORTANT: The API security groupmust be named exactly API.

a. In theSave, Delete, Void, Chg Period, andPrint Cheques cells, typeYes.

b. To store information that may be relevant or important to that specific group, type a note in theNotes
cell.

4. On the Filemenu, click Save.

TIPS:
Before you can use the API security group to access Sage 100 Contractor company data, you have
to assign a user to the API security group.

Security is set up for each individual company, not for the entire program. Each company can use
different user names and passwords. If you havemore than one company, you have to set up
passwords for multiple companies.

Then you have to assign a user to the API security group using 7-3-2 User List.

The 7-3-2 User List window controls major features dealing with users and program security.

NOTE: The user name and password created are for administrative use only. This information is for use
by the Sage Construction Anywhere Connector program only, and is not needed by the individual
employee(s) using Sage Construction Anywhere.

To assign a new user to the API security group
1. Open 7-3-2 User List.

2. In theUser Name cell, enter a user name, such as SCAUser.

3. In thePassword cell, enter a password.

4. In theGroup 1 cell, click once in the cell, and from the drop-down list, select the API group.

5. Click File > Save.

IMPORTANT: The API will not accept “supervisor” as a user name.

To assign an existing user to the API security group
1. Open 7-3-2 User List.

2. Find theUser Name for the person who will use Sage Construction Anywhere.

3. In theGroup 1, Group 2, Group 3, Group 4, orGroup 5 cell, click once in the cell, and from the drop-
down list, select the API group.

Setting up an API security group and an API user in Sage 100 Contractor
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4. Click File > Save.
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Chapter 6: Managing Your License
This chapter provides detailed information about:

Managing and activating your license

Using License Administration

License administration
When you purchase Sage 100 Contractor software, it includes the License Administration program. Using the
License Administration program, you can activate licenses andmonitor the license uses. During software
installation, the License Administration program is automatically installed on the computer that the software
installer designates as the Sage license server.

IMPORTANT: Before you can use Sage 100 Contractor with your activated license, you have to
specify the computer on your network that is the Sage license server when you launch Sage 100
Contractor.

Where is the Sage license server located?

The Sage license server is software running on a computer on your network that manages the Sage 100
Contractor products and features that you purchased. Products and features can be a “core product,”
additional “modules,” and a number of “license uses.” The computers running your Sage 100 Contractor have
to be connected to the computer running the Sage license server so that the correct products, features, and
number of license uses are available to you.

About managing licenses

Use the License Administration window to activate licenses andmonitor license uses.

Activating licenses

In order to use Sage 100 Contractor, you have to activate your product licenses.

To activate your license:

1. On the License Administration window, click theEdit registration info link.

2. Enter yourSage client ID.

3. Enter yourRegistration name.

4. Click [OK].

License Information tab

The tab, which is available from the License Administration window, displays information about your Sage 100
Contractor licenses.
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Items on this tab

Item Notes

Support
plan expir-
ation date

The date on which your support plan with Sage Customer Support expires.

Number of
requests
which
exceeded
use count
(last 90
days)

Displays the number of times the request for licenses failed in the past threemonths
because there were not enough licenses available. If there are a significant number
of requests, youmaywant to acquire additional licenses.

Last license
information
update

The last date upon which your licenses were verified with Sage's license server.

NOTE: If your system cannot connect to Sage for a period of more than 10 days, you will
receive a message indicating there is a connection problem. See Troubleshooting license
activation issues for more information.

Licensed
modules

Displays a list of licenses available to this server, based on the products you have
purchased from Sage. When you purchase new products, the licenses for those products
become available to activate here. "Canadian Edition" refers to the basic program, exclusive
of the additional modules. Themodule licenses that are not part of the core Canadian
Edition, but are available for purchase, are listed here:

Inventory

Service Receivables

Estimating

Document Control

Equipment Management
There is also a column that shows how many Canadian Edition licenses are checked out
from this license server to local machines.

Update
license
information

Click to update the license informationmanually. This connects your server to the Sage
license server, where your current license information is stored, and it updates the
information on this window. This also creates entries in the event log. View the event log to
monitor the success of your license activations.

NOTE: If you are usingmulti-server license administration, ensure you have the proper
allocations set underMulti-server licensing before you update your license information.
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Item Notes

Deauthorize
license
server

Typically, this would be used if you aremoving Sage 100 Contractor's license server from
onemachine to another machine.

IMPORTANT: You need to deauthorize the old server in the License Information tab
before you authorize Sage 100 Contractor's license server on a new server.

Multi-server
licensing

This allows you to allocate your Sage licenses tomultiple servers. For example, this
could happen if you have several corporate offices and want to use separate
licenses for each office or if you want to reserve a certain quantity of license uses for
a specific group of people.

Active Users tab

This tab of the License Administration window lists the names of all users and computers currently using
Sage 100 Contractor.

Each row in the list represents a separate license use. If you find you are running out of licenses, you can
review this list to determine if any licenses can bemade available. Tomake a license available, simply close
Sage 100 Contractor on one of the computers where the program is running.

You can restrict all users from logging on to the Sage 100 Contractor software from this tab.

Items on this tab

Item Notes

User The name of the user who is currently logged on to Sage 100 Contractor.

Computer The computer where the user is logged on to Sage 100 Contractor.

Session TheWindows session for the user.

Restrict
logon/Allow
logon

Click Restrict logon to prevent users from logging on to Sage 100 Contractor temporarily.
This prevents new users from logging on to Sage 100 Contractor but does not remove
existing users. Youmight use this feature in preparation for backing up your database, for
example.

If you have previously restricted logon, click Allow logon to allow users to log on to Sage
100 Contractor.

Event log tab

Use this tab of the License Administration window to view events related to licensing. This lists whether
license validation was successful or if there were any problems attempting to validate the licenses. See
Troubleshooting license activation issues for more information about issues validating licenses.

License administration
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Items on this tab

Item Notes

Level The level of the licensing event (for example, informational).

Date and time The date and time that the licensing event occurred.

Description

The description of the licensing event. Typically, this displays "Entitlements
updated for client," but this will also indicate if there was a problem updating the
licenses. The section below this area provides additional details about the
issue.

Clear event log Click to remove all entries in the list.

Maintaining license information
Your Sage 100 Contractor software automatically retrieves license information from Sage every day. The
licenses give you access to the various modules of Sage 100 Contractor. As you purchase or remove license
activations, the Sage license server automatically updates this information in your system. You can also
select to update the licensing informationmanually.

NOTE: Licenses are granted to the specific computer where the licenses were initially activated. If you
need tomove your Sage 100 Contractor server to a different server, youmust first deactivate the
licenses in the License Information tab on the old server before you can activate them on a new server.

To view or change license information:

1. Select License Administration program.

2. You can view or change the information here, or you can click Update license information to retrieve
current licensing information from Sage. Note that theSage client ID andRegistration namemust
match Sage's records exactly in order for the update to be successful. To change the Sage client ID or
the registration name, select Edit registration information.

NOTE: If you havemultiple servers serving your Sage 100 Contractor application, click Multi-
Server License Administration to allocate and update your licenses.

3. To view which users are logged on to Sage 100 Contractor, click theActive users tab.

4. To view the results of the previous update attempts, click Event log. Click Clear event log if you no
longer need the information.

TIP: Formore information, click while viewing the window.

Multi-Server License Administration window
Formost users of Sage 100 Contractor, it is not necessary to allocate license across multiple servers.
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If you need to allocate licenses across multiple servers, this window allows you to allocate your Sage
licenses tomultiple servers. For example, this could happen if you have several corporate offices and want to
use separate licenses for each office or if you want to reserve a certain quantity of licenses for a specific
group of people.

Because the Canadian Edition license controls the amount of license uses, it is the only license which is “use-
counted.” Therefore the only license that is allocated amongmultiple servers is the Canadian Edition license.
The additional modules are not use-based and can be used by anyone with a core Canadian Edition license
and the appropriate security permission.

Example 1—Multiple servers with specific allocations

Assume you have three servers that you want to allocate as follows:

Server Licenses

Server A 3 Canadian Edition licenses

Server B 3 Canadian Edition licenses

Server C 4 Canadian Edition licenses

At each of the servers, you would select theManually specify allocations for this server option in the
Multi-Server License Administration window, and select the number of licenses for that server.

If you later purchase additional Canadian Edition licenses, youmust go into each server where you want the
additional licenses to be allocated and update the allocation.

Example 2—Multiple servers with specific allocations for all but one server

Assume you have three servers that you want to allocate as follows:

Server Licenses

Server A 3 Canadian Edition licenses

Server B 3 Canadian Edition licenses

Server C All remaining licenses

At servers A and B, select theManually specify allocations for this server option in theMulti-Server
License Administration window, and select the number of licenses for each server.

At server C, select theAllocate all available licenses to this server option in theMulti-Server License
Administration window.

NOTE: In this example, it is important to select the option for server C last. If you select to
automatically allocate all available licenses on server C first, it will take all the available licenses and
there will be none left to allocate to servers A and B.

License administration
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If you purchase additional licenses, they will automatically be allocated to server C when the license
activations are updated, unless youmanually select the licenses to go to server A or B first.

Items on this window

Item Notes

Allocate all avail-
able licenses to
this server
(default)

If you choose this option, all licenses are allocated to this server. This is the
most common scenario. Do not choose this option if you want to allocate
licenses acrossmultiple servers.

Manually specify
license allocations
for this server in
the "Uses for
[server name]
column below

Select this option to allocate licenses acrossmultiple servers. The amount of
licenses you select in theUses for [server name] column is the amount of
licenses allocated to this server.

Module name

Displays a list of licenses available to this server, based on the products you have
purchased from Sage. When you purchase new products, the licenses for those
products become available to activate here. "Canadian Edition" refers to the basic
program, exclusive of the additional modules. Themodule licenses that are not part of
the core Canadian Edition, but are available for purchase, are listed here:

Inventory

Service Receivables

Estimating

Document Control

Equipment Management
There is also a column that shows how many Canadian Edition licenses are checked
out from this license server to local machines.

Total uses The total number of uses that are available. This displays the total number of
licenses you have purchased.
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Item Notes

Available uses

The number of uses available to this server. If some licenses have already
been allocated to a different server, it reduces the number of uses avail-
able here. For example, if you have 10 total uses, and 2 have been alloc-
ated to another server, the available uses for this server is 8.

Uses for [server
name]

The number of uses allocated to this server. You can change the number here, but
you can only add uses if there are still uses available. You can decrease uses to
makemore licenses available to other servers.

If you need to havemore uses available to this server, youmust first relinquish
licenses on one of your other servers, or purchase additional licenses.

[OK] Click to allocate the licenses selected in theUses for [server name] column to
this server.

[Cancel] Click to cancel this window without making any changes.

To open this window, open the License Administration program and on the License Information tab, click
[Multi-server licensing].

Managing licenses

Checking out and checking in a license use
You can use Sage 100 Contractor when your computer cannot actively communicate with the license server,
by checking out a license use from the Sage license server.

NOTE: Checking out a product license use removes it from the license server's pool of generally
available license uses and places it directly on the computer checking out the license. However, this
may prevent other user access to Sage 100 Contractor, so checking out a license should only be used
when necessary.

To check out a license use:

1. From the Sage 100 Contractor main window, on the Filemenu, click Check Out License Use.

2. Click Yes.

IMPORTANT: If you check out a license use, it remains checked out on this computer until you
check in the license usingCheck In License Use from the File menu.

To check in a license use:

1. From the Sage 100 Contractor main window, on the Filemenu, click Check In License Use.

2. Click Yes.

Managing licenses
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Administering a different license server
In the License Administration program, you can see the number of license uses, the users who are logged on
to Sage 100 Contractor, and licensing events for this license server.

Licenses are granted to the specific computer where the licenses were initially activated. If you need to see
the license uses available on another Sage license server, you can do that in the License Administration
window.

To administer a different license server:

1. Select the License Administration program.

2. From the License Administration window, click Administer Different Server.

3. Enter computer name or IP address. How?

Troubleshooting license issues

Troubleshooting license activation issues
Your system will automatically retrieve license information from Sage daily. The licenses give you access to
the various modules of Sage 100 Contractor. As you purchase or remove license activations, the Sage
license activation server automatically updates this information in your system.

If the server that hosts Sage 100 Contractor is unable to connect to the Sage license server for more than 10
days, you will receive amessage indicating there is a connection problem. The following are some of themore
common issues that can cause this to occur.

There is a problem with your Internet connection.

The Sage 100 Contractor server connects to the Sage license server through the Internet. Check tomake
sure the server's connection to the Internet is intact.

There is a problem with your network.

Any network issues that interrupt the Internet connection (such as firewall settings) can prevent the Sage 100
Contractor server from connecting to the Sage license server. Confirm that your firewall is configured
correctly and that all network components are operating properly.

The registration information does not match.

TheSage client ID andRegistration Name on the License Administration window must match the
information on the Sage license server. Ensure the information is entered correctly here.

You have exceeded your license activations.

You do not have enough licenses to support everyone attempting to use Sage 100 Contractor. Youmay want
to purchasemore licenses.
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TIP: TheNumber of requests which exceeded use count box on the License information tab of the
License Administration window displays the number of times in the last threemonths that requests for
licenses have exceeded the number of licenses available.

Troubleshooting license issues
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Chapter 7: License Use and Sage 100
Contractor
This chapter provides all the necessary details about:

Specifying the Sage license server

Managing license attributes

Understanding license uses

Specify Sage License Server

What is a server?
There aremany kinds of servers. Some servers are denoted by their hardware configuration and a specialized
operating system. Other servers consist of specialized software applications running on standard computers.

Some servers are called “file servers” andmay be a powerful computer dedicated to storing files and data. For
example, Sage 100 Contractor company data can be stored on a file server. Any Sage 100 Contractor user on
the same network as the file server can access and store data there.

A server can also be a software application that provides a specific kind of service to client software running
on other computers. The term server can refer to a particular piece of software, such as the Sage license
server. When we refer to the Sage license server, we are describing a computer that is running the Sage
license server software.

Before you can use Sage 100 Contractor with your activated license, you have to specify the computer on
your network that is the Sage license server. There are two ways to specify the Sage license server:

You can select the computer from the list of computers on your network; or

You can enter the IP Address or name of the computer.

Selecting the Sage license server computer
Onemethod is to select the computer running the Sage license server from the list of network computers.

NOTE: To use this method of selecting a server from the list of network computers, youmust have
already clicked the appropriate link on the Specify Sage License Server window.

To select the computer running Sage license server from the list of network computers:

1. On the Select License Server window from the list of network computers, select the computer running
the Sage license server.

2. Click [OK].
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Entering the IP Address or name of the computer
Onemethod is to enter the IP Address or name of the computer running the Sage license server.

To enter the IP Address or name of the computer running the Sage license server:

1. In the text box, type the IP Address or name of the computer.

2. Click [OK].

What is an IP Address?
Every computer connected to the Internet is assigned a unique number known as an Internet Protocol (IP)
address. This numeric address of a computer on the Internet is written as a set of four numbers separated by
periods (each number can range from 0 to 255). An example of an IP Address is 123.123.4.5.

Determining the IP Address of a computer

NOTE: If you are trying to determine the IP Address computer running the Sage license server, you
must complete this procedure on that computer.

To determine the IP Address of a computer:

1. Click Start > Run.

2. In the Open text box, type cmd, and then click [OK].

The \Windows\...\cmd.exe window appears.

3. At the prompt, type ipconfig.

For example, youmight see H:\. Type ipconfig after the drive letter.

4. Press the [Enter] key.

The system displays several addresses including the IP Address of the computer, similar to this line:

IP Address . . . . . . . .172.20.22.142

Determining the name of a computer

NOTE: If you are trying to determine the name of the computer running the license server, youmust
complete this procedure on that computer.

To determine the name of a computer:

1. On yourWindows desktop, click Start > Settings> Control Panel.

2. From the list, scroll to and then double-click System.

TheSystem Propertieswindow appears.

3. Locate the line Full computer name, and thenmake a note of the name.

4. Click [Cancel].
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Chapter 8: Special Configurations—
Operating Systems and Services
This chapter contains information about special configurations for specific operating systems, such as:

Windows 8 Professional and Server 2012 Standard

Windows® 7 Professional andWindows Server 2008® R2 Standard

Windows Vista® andWindows Server 2008

Citrix® and Terminal Servers

Windows 8 Professional and Server 2012 Standard Operating
Systems

Windows 8 Professional and Server 2012 Standard "Sleep Mode"
prevents computers from obtaining a license use
If a computer running theWindows 8 Professional or Server 2012 Standard operating system is used as a
license server, when it goes into sleepmode other computers on the network can’t obtain a license.

To avoid this possibility, set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to “Never”:

1. Start > All apps > Control Panel > System and Security > Power Options.

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-
start on Windows 8
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers
running theWindows 8 Professional orWindows 8 Enterprise operating systems. If the service stops, the
program displays amessage advising you to take further action to resolve this issue.

Solution for Server 2012 error message about mb7.kpr file
If you encounter an error message about opening themb7.kpr file when launching Sage 100 Contractor on a
computer runningWindows Server 2012, follow these steps to resolve the issue:

1. On theWindow desktop, right-click Start, and then click Explore.

2. On the left side of the window, under Folders, right-click theMB7 folder, and then select Properties.

3. On theMB7 Propertieswindow, click theSecurity tab.
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4. From the list underGroup or User Names, select USERS, and then click [Edit].

5. On thePermissionswindow, select USERS again, and underAllow, select the Full control check
box.

(Selecting Full control selects all the check boxes necessary for this solution.)

6. On thePermissionswindow, click [OK].

7. On theMB7 Propertieswindow, click [OK].

Server 2012 network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable
communication among computers on a network. File and printer sharing on computers running the Server
2012 operating systemmust be enabled. To enable file sharing, follow the instructions in theWindows Server
2012 Help.

Windows 7 Professional and Server 2008 R2 Standard
Operating Systems

Windows 7 Professional, Windows 8 Professional, and Server 2008 R2
Standard "Sleep Mode" prevents computers from obtaining a license use
If a computer running theWindows 7 Professional, Windows 8, or Server 2008 R2 Standard operating system
is used as a license server, when it goes into sleepmode, other computers on the network can’t obtain a
license.

Set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to “Never”:

1. Start > Control Panel > System and Security > Power Options.

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-
start on Windows 7 Professional and Server 2008 R2 Standard
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers
running theWindows 7 Professional or Server 2008 R2 Standard operating systems. If the service stops, the
program displays amessage advising you to take further action to resolve this issue.

Solution for Server 2008 R2 error message about mb7.kpr file
If you encounter an error message about opening themb7.kpr file when launching Sage 100 Contractor on a
computer runningWindows Server 2008 R2, follow these steps to resolve the issue:
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1. On theWindow desktop, right-click Start, and then click Open Windows Explorer.

2. On the left side of the window, underComputer > Local Disk, right-click the \MB7 folder, and then
select Properties.

3. On theMB7 Propertieswindow, click theSecurity tab.

4. From the list underGroup or User Names, select USERS, then click the [Edit] button.

5. On thePermissionswindow, select USERS again, and underAllow, select the Full control check
box.
Selecting Full control, selects all the check boxes necessary for this solution.

6. On thePermissionswindow, click [OK], and then on theMB7 Propertieswindow, click [OK].

Server 2008 R2 network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable
communication among computers on a network. File and printer sharing on computers running the Server
2008 R2 operating systemmust be enabled. To enable file sharing, follow the instructions in theWindows
Server 2008 R2Help.

Windows Server 2008 R2 and Microsoft .NET 3.5.1
Microsoft .NET 3.5.1 must be available and enabled prior to installing Sage 100 Contractor on aWindows
Server 2008 R2machine. Server 2008 R2 comes with .NET 3.5.1 loaded but not installed, so Sage 100
Contractor doesn’t install it automatically.

If you attempt to install Sage 100 Contractor without .NET 3.5.1 installed, you will receive the following
message during the licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.”
When you click [OK], the installation continues, but the services have not been installed so Sage 100
Contractor cannot open. The Sage.CRE.HostingFramework Service will not install unless .NET 3.5.1 has
been installed. If you receive the abovemessage during installation, install .NET Framework 3.5.1 and
reinstall Sage 100 Contractor.

To verify that .NET 3.5.1 is installed on Windows Server 2008 R2:

1. Click theStart button in the lower left corner of the display.

2. Highlight Administrative Tools and select Server Manager.

3. In theServer Manager interface, click Features to display all the installed Features in the right-hand
pane. Verify that .NET Framework 3.5.1 is listed.

To enable .NET 3.5.1 on Windows Server 2008 R2:

1. In theServer Manager interface, select Add Features to display a list of possible features.

2. In theSelect Features interface, expand .NET Framework 3.5.1 Features.

3. Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next
to .NET Framework 3.5.1 and click Next.

Windows 7 Professional and Server 2008 R2 Standard Operating Systems
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4. In theConfirm Installation Selections interface, review the selections and then click [Install].

5. Allow the installation process to complete and then click [Close].

NOTE: Enabling .NET Framework 3.5.1may require a reboot.

Windows Vista and Server 2008 Operating Systems

Vista and Server 2008 “Sleep Mode” prevents computers from obtaining
a license use
If you are using a Vista or Server 2008 computer as the Sage license server and it goes intoSleep Mode, the
workstations cannot obtain a license use.

Use a different computer on your network to be the Sage license server. Any supported operating system can
be used in place of Vista or Server 2008.

Set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to "Never":

1. Start > Control Panel > System and Maintenance > Power Options.

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-
start on Vista, Windows 7, Windows 8, or Server 2008

IMPORTANT: Read this information if you are running Vista or Server 2008 operating systems on your
office computers.

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers
running the Vista, Windows 7, Windows 8, or Server 2008 operating systems. If the service stops, the
program displays amessage advising you to take further action to resolve this issue.

Solution for Server 2008 error message about mb7.kpr file
If you encounter an error message about opening themb7.kpr file when launching Sage 100 Contractor on a
computer runningWindows Server 2008, follow these steps to resolve the issue:

1. On theWindow desktop, right-click Start, and then click Explore.

2. On the left side of the window, under Folders, right-click theMB7 folder, and then select Properties.

3. On theMB7 Propertieswindow, click theSecurity tab.

4. From the list underGroup or User Names, select USERS, then click [Edit].

5. On thePermissionswindow, select USERS again, and under Allow, select the Full control check
box.
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Selecting Full control selects all the check boxes necessary for this solution.

6. On thePermissionswindow, click [OK], and then on theMB7 Propertieswindow, click [OK].

Vista, Windows 7, and Server 2008 network configuration and TCP
Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable
communication among computers on a network. File sharing on computers running the Vista, Windows 7, or
Server 2008 operating systemmust be enabled. To enable file sharing, follow the instructions in the
Vista, Windows 7, or Server 2008 Help.

Vista, Windows 7, and Server 2008 and changing the Sage License
Server computer
On a Vista, Windows 7, or Server 2008 workstation, when you select File > Change Sage License Server >
Select the computer from the list of computers on your network, the commandmay fail to generate a list
of network computer names. To resolve this issue, click Enter the IP address or name of the computer,
and then type the IP address of the server computer in the box.

Citrix and Terminal Servers

Using Citrix and Terminal Server with Sage 100 Contractor
Many people use Citrix and Terminal Server to manage remote access to their local area network (LAN). If
Sage 100 Contractor is installed on the computer running Citrix or Terminal Server and on your laptop, then
youmay log on to the computer running Citrix or Terminal Server with your laptop and work in Sage 100
Contractor on your LAN. This enables you to work from home, from a job site, or from any number of other
remote locations.

We recommend that you use DOS commands to change the operatingmode from “execute” to “install” and
then back to “execute.”When using the DOS commands to install, youmay install the Sage 100 Contractor
software as you would on any desktop orWindows server operating system that meets Sage 100 Contractor
requirements.

Installing on computers running Citrix and Terminal Server using DOS
commands
To install using DOS commands:

1. Click [Start] > Run.

2. On theRunwindow:

a. In theOpen drop-down box, type cmd.

b. Press [Enter].

The \Windows\...\cmd.exewindow appears.

Citrix and Terminal Servers
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3. When prompted, type change user /install, and then press [Enter] to turn on the Install mode.

4. Install Sage 100 Contractor as you would on a typical workstation orWindows Server.

5. At the end of the installation process, launch License Administration Tool.

6. Use the License Administration Tool window to activate andmanage your license.

7. After activation, click Start > Run.

8. On the Run window, in the Open drop-down box, type cmd, and then press [Enter].

The \Windows\...\cmd.exewindow appears.

9. When prompted, type change user /execute to turn on the Executemode, the default mode for running
Citrix and Terminal Server.

10. Exit theRunwindow.

11. Restart the server.

IMPORTANT: If this message appears: “Install mode does not apply to a terminal server configured for
remote administration,” then it is not necessary to enable the install mode. Youmay install the Sage 100
Contractor software as you would on a typical workstation.

Backing Up Your Data
With any computer system, there is the possibility for failure and loss of data.

CAUTION: Use a backupmethod and device suitable for your business requirements. We strongly
recommend that youmaintain a routine backup schedule and store your data in a safe environment that
is separate from your server, preferably off site.

Which files to back up in Sage 100 Contractor

NOTE: This topic applies only to existing Sage 100 Contractor customers.

When you back up your company data, we recommend that you back up your company financial data as well
as all your custom reports and forms. If you are runningmultiple Sage 100 Contractor companies, back all of
them up.

When backing up data as part of the year-end close process, it is important to count the number of files and
folders in your company.

To see the number of files and folder in a company folder, inWindows Explorer, right-click the company folder
and select Properties. On the Properties window, the General tab, look in the list for the Contains line for the
number of files and folders. Write this number down so that you can refer to it after you havemade the two
copies. The number of files and folders has to be exactly the same in both the company and the backup copy.

We strongly recommend that you back up:
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Each company folder that contains financial data (\MB7\Your Company\)

TheSage 100 Contractor folder (\Users\Username\AppData\Local\Sage\Sage 100 Contractor)

TheReport Forms folder (\MB7\Report Forms)

TheCustom Reports folder (\MB7\Custom Reports)

IMPORTANT: When backing up your data, be sure tomake a full backup and not an incremental or
differential backup. An incremental or differential backup only records alterations to the data since the
last backup.

An example of one backup method
There are various methods for backing up your data. Depending on the amount of data you enter routinely,
consider making full daily backup copies. It is also a good idea to regularly take one copy off the business
premises or store your backed-up data in a fireproof safe. If a burglary or fire occurs, a copy of your data is
safe from harm.

One reliable procedure, requiring a tape drive andmultiple sets of tapes, requires you to back up your data
daily andmonthly.

Daily Backup Process

For the daily backup process, you need 10 tapes. Label five of the tapes as Week A, with a tape designated
for each weekday. Label the other five tapes as Week B, with a tape designated for each weekday.

Start with the set of tapes labeledWeek A. Monday night when youmake the backup use the tape labeled
Monday, on Tuesday use the tape labeled Tuesday, and so forth. At the start of the next week, use the set of
tapes labeledWeek B tomake your backup copies. At the end of two weeks, you will have backed-up data for
each day. Then at the start of the third week, use the set of tapes labeledWeek A again. Over the course of a
year, you will cycle through the two sets of tapes. Be sure to store themost recent Friday backup off site.

Monthly Backup Process

For themonthly backup process, you need a separate set of three tapes labeledMonth A, Month B, andMonth
C respectively. Like the weekly backups, use each tape to back up the data for a different month, cycling
through each of the tapes over the course of the year. After making amonthly backup copy, write themonth
and year on the label to help you track which tape to use next. Be sure to remove themost recent monthly
backup off site.

Backing up your data to a CD or DVD
This topic suggests a generic way to back up your data to a CD or DVD. Backing up to a CD or DVD
successfully depends on your computer system, including hardware and software. To back up to a CD or
DVD, youmust have access to a CD or DVD (Read/ Write capability), and the appropriate CD or DVD media.

When backing up data as part of the year-end close process, it is important to count the number of files and
folders in your company. To see the number of files and folder in a company folder, inWindows Explorer, right-
click the company folder and select Properties. On the Properties window, the General tab, look in the list for
the Contains line for the number of files and folders. Write this number down so that you can refer to it after
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you havemade the two copies. The number of files and folders have to be exactly the same in both the
company and the backup copy.

IMPORTANT: If you are working across a network, youmust remember to backup company folders,
report folders, and form folders that reside at the server.

To back up your data to a CD or DVD
1. Place the CD or DVD media in the CD or DVD.

2. On yourWindows desktop, right-click [Start] > Explore.

3. InWindows Explorer:

a. Locate and then right-click the \Users\Username\AppData\Local\Sage\Sage 100 Contractor folder.

b. From themenu, select Copy.

4. Locate and then click the CD or DVD drive.

5. In the right-pane, right-click and then select [Paste].

6. InWindows Explorer:

a. Locate and then right-click the \MB7\ folder.

b. From themenu, select Copy.

7. Locate and then click the CD or DVD drive.

8. In the right-pane, right-click and select [Paste].
Depending on your hardware and software, the folder will be copied to the CD or DVD media. For further
information or support, contact your CD or DVD manufacturer.

Configuring Windows Regional and Short Date Format
To specify regional formats for Windows:

1. Click the [Start] button, point toControl Panel, then click Clock, Language, and Region .

2. Click Region and Language.

3. On the Formats tab, select the format for your country.

4. UnderDate and time formats, from the Short date format drop-down list, select the format used for
your country.

5. Click [OK].

6. Close theClock, Language, and Regionwindow.
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